All information herein is either public information or is the property of and owned solely by Thales DIS France S.A. and/or its subsidiaries or affiliates who shall have and keep the sole right to file patent applications or any other kind of intellectual property protection in connection with such information.

Nothing herein shall be construed as implying or granting to you any rights, by license, grant or otherwise, under any intellectual and/or industrial property rights of or concerning any of Thales DIS France S.A. and any of its subsidiaries and affiliates (collectively referred to herein after as “Thales”) information.

This document can be used for informational, non-commercial, internal and personal use only provided that:

- The copyright notice below, the confidentiality and proprietary legend and this full warning notice appear in all copies.
- This document shall not be posted on any network computer or broadcast in any media and no modification of any part of this document shall be made.

Use for any other purpose is expressly prohibited and may result in severe civil and criminal liabilities.

The information contained in this document is provided "AS IS" without any warranty of any kind. Unless otherwise expressly agreed in writing, Thales makes no warranty as to the value or accuracy of information contained herein.

The document could include technical inaccuracies or typographical errors. Changes are periodically added to the information herein. Furthermore, Thales reserves the right to make any change or improvement in the specifications data, information, and the like described herein, at any time.

Thales hereby disclaims all warranties and conditions with regard to the information contained herein, including all implied warranties of merchantability, fitness for a particular purpose, title and non-infringement. In no event shall Thales be liable, whether in contract, tort or otherwise, for any indirect, special or consequential damages or any damages whatsoever including but not limited to damages resulting from loss of use, data, profits, revenues, or customers, arising out of or in connection with the use or performance of information contained in this document.

Thales does not and shall not warrant that this product will be resistant to all possible attacks and shall not incur, and disclaims, any liability in this respect. Even if each product is compliant with current security standards in force on the date of their design, security mechanisms’ resistance necessarily evolves according to the state of the art in security and notably under the emergence of new attacks. Under no circumstances, shall Thales be held liable for any third party actions and in particular in case of any successful attack against systems or equipment incorporating Thales products. Thales disclaims any liability with respect to security for direct, indirect, incidental or consequential damages that result from any use of its products. It is further stressed that independent testing and verification by the person using the product is particularly encouraged, especially in any application in which defective, incorrect or insecure functioning could result in damage to persons or property, denial of service or loss of privacy.

©2020 Thales Group. All rights reserved. Thales, the Thales logo and Sentinel are trademarks and service marks of Thales and/or its subsidiaries and affiliates and are registered in certain countries. All other trademarks and service marks, whether registered or not in specific countries, are the properties of their respective owners.

**Product Version:** 7.8 and later  
**Document Part Number:** 000-000000-001, Rev. A, 2005-1  
**Document Release Date:** May 2020
CONTENTS

Introduction ............................................................................................................................ 5
About Sentinel LDK ..................................................................................................................... 5
About This Guide ....................................................................................................................... 5
Types of Protection Keys ............................................................................................................. 6
Sentinel SL Keys ......................................................................................................................... 6
Sentinel HL Keys ......................................................................................................................... 6
Support Contacts ...................................................................................................................... 7

CHAPTER 1: Migrating the Business Studio Server Database to Sentinel EMS Database .................................................................................................................. 8

Overview ................................................................................................................................. 8
Target Audience ........................................................................................................................ 8
Who Needs the Migration Process? ............................................................................................ 8
Who Does NOT Need the Migration Process? ............................................................................. 8
Migration Paths for HASP SRM and Sentinel HASP ................................................................. 9
Summary of the Migration Process ........................................................................................... 9
Migrating a Large BSS Database ............................................................................................. 9
Changes at Customer Sites ....................................................................................................... 10
Replacing the Sentinel HASP Activation Server ....................................................................... 10
Method A: Modify the DNS Address ......................................................................................... 10
Method B: Change the Sentinel EMS Port Number .................................................................... 10
Additional Activation Methods ............................................................................................... 11
Working with Business Studio Server API ................................................................................ 11
Which Data is Migrated? .......................................................................................................... 12
Limitations and Workarounds ................................................................................................. 12
Distribution Channel Functionality .......................................................................................... 12
Reports ...................................................................................................................................... 12
User Name ............................................................................................................................... 12
Customer Attributes ................................................................................................................ 13
Miscellaneous Field Reassignments ........................................................................................ 13
Migration of Orders for HASP HL Max Micro Keys ................................................................. 14
Migration of Products That Do Not Contain Features ............................................................ 14
Migration of Completed Orders in the Demo Database ........................................................... 14
Performing a Trial Migration.................................................................................................... 14
Preparing for Migration .......................................................................................................... 14
Estimate Time Required for Migration .................................................................................... 14
Install SQL Server Management Studio Express and Back Up Your BSS Database .......... 15
Install and Back Up Sentinel EMS .......................................................................................... 15
Set Up Sentinel LDK Data Migration Tool ............................................................................... 15
Determine Batch Codes to be Migrated .................................................................................. 16
Ensure That Sentinel EMS and BSS Database Services are Active ........................................ 16
Ensure That the Required Master Keys are Connected .......................................................... 16
Contents

Back Up Sentinel EMS Database and BSS Database (Optional) ......................................................... 16
Migrating the BSS Database .............................................................................................................. 17
  Run the Sentinel LDK Data Migration Tool .................................................................................... 17
  Reintroduce the Master Keys .......................................................................................................... 20
Verifying the Success of the Migration Process .................................................................................. 20
Stopping the SQL Service for the BSS Database .............................................................................. 21
Migrating Backend Systems That Use BSS API ............................................................................... 21
Performing BSS and Sentinel EMS Database Rollback in Case of Failure ........................................ 21

CHAPTER 2: Implementing the Business Studio Server API for Sentinel EMS ......................... 22
Overview ........................................................................................................................................... 22
Prerequisites ..................................................................................................................................... 22
Functionality Changes ....................................................................................................................... 22
  GetExecutableFromV2C .................................................................................................................... 22
  GetKeyHistoryByKeyID Method ....................................................................................................... 23
  AddProductsToOrder Method .......................................................................................................... 23
  InsertCustomer Method .................................................................................................................. 23
  Retrieving Orders Based on Order ID ............................................................................................. 23
  Retrieving Customers Based on Customer ID .................................................................................. 24
Other Changes to BSS API Functions .............................................................................................. 24
Setting Up Business Studio Server API for Sentinel EMS ............................................................... 25
  As an ASP.NET SOAP Web Service ................................................................................................. 25
  Local (As a .NET DLL) ..................................................................................................................... 27

APPENDIX A: Working With the Sentinel EMS Web Interface .................................................. 29

APPENDIX B: Troubleshooting ....................................................................................................... 31
  TCP/IP Access Is Not Enabled for the BSS Database ................................................................... 31
  The Master Wizard Returns Error Code 850, 852, or 857 ............................................................... 33
  Migration Tool Fails to Back Up BSS Database or EMS Database ............................................... 34
  Migration Tool Freezes During the Pre-migration Process ............................................................. 34
  BSS API for EMS Fails to Generate Log Files .............................................................................. 35

APPENDIX C: Replace Obsolete Certificate ................................................................................. 36
Before you begin .................................................................................................................................. 36
  Enable SSL (HTTPS) in Sentinel EMS ......................................................................................... 36

APPENDIX D: Modify Product Key Validation ............................................................................... 37
About Sentinel LDK

Sentinel® LDK is a Software Digital Rights Management (DRM) solution that delivers strong copy protection, protection for Intellectual Property, and secure and flexible licensing. Sentinel LDK is an all-in-one Software DRM solution that enables you to choose a hardware- or software-based protection key, based on business considerations. Sentinel LDK software engineering and business processes are completely separate to ensure:

- Effective and efficient product development
- Quick time to market
- Immediate addressing of customer and market needs
- Comprehensive support throughout the software product’s protection and licensing life cycle

The level of protection for your software is determined by the locking type you choose—hardware-based or software-based. Sentinel LDK hardware-based protection, which utilizes Sentinel HL keys, provides the safest and strongest level of protection.

About This Guide

This guide is intended for the following types of software vendors:

- Vendors who currently use the (Sentinel HASP) Business Studio Server database to manage orders and licenses for Sentinel HASP. This guide describes how to migrate to the Sentinel EMS database and Sentinel LDK. For more information, see “Migrating the Business Studio Server Database to Sentinel EMS Database” on page 8.

- Vendors who currently use the Sentinel HASP Business Studio Server API. You can implement a modified version of the Business Studio API that allows your CRM and ERP applications to access the Sentinel EMS database using existing Business Studio API function calls. This avoids the need to convert your applications to use Sentinel Web Services. For more information, see “Implementing the Business Studio Server API for Sentinel EMS” on page 22.

**NOTE:** Sentinel LDK introduces the Sentinel License Generation API. This API provides an alternative to working with Sentinel EMS. Sentinel License Generation API provides access to the power and flexibility of Sentinel protection keys without the need to install the full Sentinel EMS system. (You can use Sentinel LDK ToolBox to examine the API functions, create license templates, and to generate protection keys.)

There are several disadvantages to working with Sentinel License Generation API. The API does not support a database and does not support automated online activation. Vendors who use this API should develop an alternative method to store resultant states and C2V files for easy updates.
Types of Protection Keys

This section describes the types of protection keys that are available for Sentinel LDK.

Sentinel SL Keys

The following types of Sentinel SL keys are available in Sentinel LDK:

- Sentinel SL Legacy keys
  
  These are the Sentinel SL keys that existed in Sentinel HASP until now. These keys can continue to be used without upgrading the Run-time Environment on the end user’s computer. However, these keys are not compatible with new functionality introduced in Sentinel LDK such as the rehosting of a protection key to a different computer by the end user.

  When you use Sentinel LDK to perform any type of update to a Sentinel SL Legacy key on an end user’s computer, the key is automatically upgraded to a Sentinel SL AdminMode key - unless you specify otherwise.

- Sentinel SL AdminMode keys
  
  These are a more advanced model of the Sentinel SL key. These keys are compatible with more advanced functionality in Sentinel LDK such as the rehosting of a protection key to a different computer by the end user. However, these keys require later versions of the Run-time Environment.

- Sentinel SL UserMode keys
  
  This is a new type of SL key that does not require the presence of the Run-time Environment. Certain limitations apply to this type of key. The security provided by Sentinel SL UserMode keys is not as strong as that provided by SL AdminMode keys. SL UserMode keys do not support concurrency.

Sentinel HL Keys

The following types of Sentinel HL keys are available, replacing the HASP HL keys that were provided until now:

- Sentinel HL (HASP configuration) keys
  
  These keys are fully compatible with existing HASP HL keys and with older generations of HASP keys. These keys can work with your existing API libraries and Run-time Environment, and you can work with your current backend environment. These keys can be upgraded at the customer site to Sentinel HL (Driverless configuration) keys and can thus provide all the benefits provided by the Driverless keys. For information on upgrading Sentinel HL (HASP configuration) keys to the Driverless configuration, see the Sentinel LDK Software Protection and Licensing Guide.

- Sentinel HL (Driverless configuration) keys
  
  These keys make use of HID drivers (included in the Windows operating system) instead of Gemalto drivers. These keys can be used without installing the Runtime Environment. To use these keys, your protected application must include the Licensing API libraries from the current version of Sentinel LDK, and you must be working with the backend from the current version of Sentinel LDK.

Vendors who are currently working with Sentinel HASP (or HASP SRM) HL keys have the following options:

- Remain with their current (Business Studio Server) back end, Run-time Environment and Run-time API libraries, and order Sentinel HL (HASP configuration) keys.

- Migrate to Sentinel LDK (as described in this migration guide), but order Sentinel HL (HASP configuration) keys. It is not necessary to replace their current API libraries or Run-time Environment.
> Migrate to Sentinel LDK (as described in this migration guide), and order Sentinel HL (Driverless configuration) keys. It is necessary in this case to replace their current API libraries and Run-time Environment.

**Support Contacts**

You can contact us using any of the following options:

**Business Contacts**

To find the nearest office or distributor, go to:

https://cpl.thalesgroup.com/software-monetization/contact-us

**Support**

To obtain assistance in using Thales Sentinel products (https://cpl.thalesgroup.com/software-monetization/all-products), feel free to contact our Support team:

> **Support Essentials** (contact details, support plans, and policies):
  > https://supportportal.thalesgroup.com/csm?id=support_essentials
> **For Issues Related to Using the Portal**: portal.support.DIS@thalesgroup.com
> **Phone**:
  > • In North America, call 800-545-6608 (US toll free).
  > • Internationally, call +1-410-931-7520.
  > • For a list of regional numbers, go to: https://supportportal.thalesgroup.com/csm?id=sentinel
    → Click **Contact Us** in the top-right corner of the page.

**Downloads**

You can download installers and other updated components from:

https://cpl.thalesgroup.com/software-monetization/sentinel-drivers
Overview

Sentinel EMS introduces a new database that is different from the database used by Sentinel HASP.

The Sentinel LDK Data Migration Tool migrates the data from an existing Sentinel HASP Business Studio Server database (BSS database) to a Sentinel EMS database.

Using this tool, you can handle the transition from Sentinel HASP BSS to Sentinel EMS with a relatively small effort. Wherever possible, the Data Migration Tool creates required new entities automatically or converts existing entities as required.

This section describes how to use the Sentinel LDK Data Migration Tool to perform this process.

**NOTE:** The migration process is not reversible. No procedure is provided to migrate data from the Sentinel EMS database to the Sentinel HASP BSS database.

Target Audience

Who Needs the Migration Process?

You may require the migration process if you are currently working with HASP SRM or Sentinel HASP, and you want to advance to the current version of Sentinel LDK.

(For vendors who require Language Packs for Sentinel EMS Vendor Portal and Sentinel LDK Vendor Tools: Language Packs will be made available several months after the current version of Sentinel LDK is released. For more information, contact your Gemalto sales representative.)

Who Does NOT Need the Migration Process?

You do not need the migration process if any of the following describe your situation:

> You use only HL Basic keys.
> You do not use Business Studio Server.
> You do not need the information contained in the Business Studio database.

In these cases, simply install Sentinel LDK on a different machine and start to use it.
Migration Paths for HASP SRM and Sentinel HASP

This section describes the paths for migrating from earlier versions of HASP SRM and Sentinel HASP to Sentinel LDK.

- To migrate from Sentinel HASP v.5.0, v.5.10 or v.5.12:
  - Follow the procedures in this migration guide.
- To migrate from HASP SRM v.3.x or v.4.x:
  - First upgrade to Sentinel HASP 5.12. Refer to the Sentinel HASP v.5.12 Installation Guide for information on how to upgrade from earlier versions of HASP SRM.
  - After upgrading to Sentinel HASP v.5.12, follow the procedures in this migration guide.

Summary of the Migration Process

The migration process consists of the sequence of procedures that follows. Each of these procedures is described in this migration guide.

1. Install SQL Server Management Studio Express and back up your BSS database
2. Install Sentinel EMS and back up the Sentinel EMS database.
3. Set up Sentinel EMS Data Migration Tool.
4. Select the Batch Codes to be migrated.
5. Review the limitations and workarounds. Determine which issues will require corrective actions. If necessary, perform pre-migration modifications to the Business Studio Server database.
6. In parallel, if you work with Business Studio Server API, prepare modifications to your current ERP and CRM systems to work with Business Studio Server API for Sentinel EMS.
7. Perform a trial migration. Review the results to ensure that you are satisfied with the migrated Sentinel EMS database.
8. When you are satisfied with the migration process, perform the migration of your production database:
   a. (If you use the Sentinel HASP Activation API to activate licenses online) Disconnect the Activation Server from the Internet.
   c. Verify the success of the migration.
   d. Enable Product activation.
9. Migrate the backend systems that use Business Studio Server API.

Migrating a Large BSS Database

To migrate a large BSS database, be sure to install the appropriate edition of Microsoft SQL Server:

- Microsoft SQL Server 2014 Express Edition database size is limited to 10 GB.
- Microsoft SQL Server Standard and Enterprise Editions have much larger database size limit.
Changes at Customer Sites

If you work with HASP SL licenses, you must ensure that customers who receive new or updated HASP SL keys install Sentinel LDK Run-time Environment v.6.23 or later.

Once the Run-time Environment v.6.23 or later is installed, HASP SL keys that were created with Sentinel HASP Business Studio will appear in the Sentinel Admin Control Center as "SL-Legacy" keys. Any SL-Legacy key for which you issue an update using Sentinel LDK can be optionally changed to an "SL-AdminMode" key.

For information on the different types of HASP SL keys used in Sentinel LDK, see the Sentinel LDK Software Protection and Licensing Guide.

Replacing the Sentinel HASP Activation Server

**NOTE:** You can skip this section if you do not use online activation or if you only use HL keys.

If you currently use the Sentinel HASP Activation API to activate licenses online, you must plan for a period of downtime, followed by a changeover from the Sentinel HASP Activation Server to Sentinel EMS.

The change from Sentinel HASP Activation Server to Sentinel EMS is accomplished using one of the methods described in this section.

Note the following:

- If you are migrating from Sentinel HASP 5.0, you must replace the Business Studio Server certificate file as part of the migration process. For more information, see "Replace Obsolete Certificate" on page 36.
- If you have added an integrity check (using the Sentinel Activation API) to verify that the entered Product Key type is valid, see "Modify Product Key Validation" on page 37.

**Method A: Modify the DNS Address**

*This method is suitable when you install the Sentinel EMS database on a different machine than the BSS database.*

The protected applications that you distribute to customers contain a URL that points to the Activation Server DNS address.

At the start of the migration process, disconnect the Activation Server machine from the internet so that customers do not perform activations during the migration.

At the end of the migration process, after you determine that the conversion was successful, modify the DNS address to point to the Sentinel EMS computer.

**Method B: Change the Sentinel EMS Port Number**

*This method is suitable when you install the Sentinel EMS database on the same machine as the BSS database.*

By default, the protected applications that you distribute to customers communicate with the Activation Server using port 443.
Migrating the Business Studio Server Database to Sentinel EMS Database

Install Sentinel EMS on the machine that contains the Sentinel HASP Activation Server. The installation must be performed using the **Advanced** setup type, and you must select the **Use SSL** option in EMS Host Configuration. In addition, you must use a different port than the port used by Business Studio Server.

At the start of the migration process, disconnect the Activation Server machine from the internet so that customers do not perform activations during the migration.

At the end of the conversion process, after you determine that the conversion was successful, disable the Business Studio Server service. Modify Sentinel EMS to use the same port that was used for the Activation Server.

Restart Sentinel EMS. Reconnect the machine to the internet.

**Additional Activation Methods**

Sentinel EMS provides additional methods to perform activation of a product:

> Sentinel EMS Customer Portal

The Sentinel EMS Customer Portal is a Web portal that your customers can access in order to activate trialware or regular Products. The customer logs in to the Customer Portal using a Product Key that you generate and provide through Sentinel EMS. The customer completes a registration form (if you require this) and then chooses the method to activate the Product. Online activation is completely automatic and locks the license to the local machine. Offline activation enables the customer to download a utility that can be used to activate the license manually on a different machine.

> Sentinel EMS Web Services

This is an API that you can use to programmatically call services to perform functions in Sentinel EMS. You can implement one of these methods as part of the migration process or at any later time.

**Working with Business Studio Server API**

*NOTE:* You can skip this section if you do not work with Business Studio Server API.

If you currently use the Business Studio Server API to perform functions in Sentinel HASP, note that Sentinel LDK provides a comparable web services interface to perform actions in Sentinel EMS.

However, to protect your investment in your current ERP and CRM systems and provide backwards compatibility, Sentinel LDK provides Business Studio Server API for Sentinel EMS. This is an updated version of Business Studio Server API that translates API function calls into the equivalent Sentinel EMS web services. Thus, after migration to Sentinel EMS, you can continue to use your existing backend systems with practically no modification.

Note that certain Business Studio Server API function calls are not supported or may require some modification.

Before you undertake the migration of your BSS database to Sentinel EMS, you must be ready to implement Business Studio Server API for Sentinel EMS in your backend systems. This is necessary so that your backend systems will be ready to work with the Sentinel EMS database as soon as the migration is completed.

For more information, see “Implementing the Business Studio Server API for Sentinel EMS” on page 22.”
Which Data is Migrated?

By default, each entity that exists in the BSS database will be migrated to the Sentinel EMS database. (You can limit the Batch Codes for which data is migrated. See “Determine Batch Codes to be Migrated” on page 16.)

You can run the Data Migration Tool more than once for a given set of databases. However, in subsequent executions of the Migration Tool, only items that do not already exist in the Sentinel EMS database will be migrated. Thus, for example:

> A Feature that has been migrated to the Sentinel EMS database will not be migrated a second time even if the Feature was modified in the BSS database after the first migration.

> Given that both the following are true for a given user account:
  - The user account is associated with two Batch Codes.
  - The user account was migrated together with data for the first Batch Code.

The user account is not migrated a second time if data for the second Batch Code is migrated in a separate execution of the Migration Tool. If the user account was modified between the two executions of the Migration Tool, the modifications will not be present in the Sentinel EMS database.

Limitations and Workarounds

While Sentinel EMS provides significant advantages over Business Studio Server, some functionality that exists in Business Studio Server is not present in Sentinel EMS. This section describes these limitations and any available workarounds.

Distribution Channel Functionality

The Distribution Channel functionality that exists in Sentinel HASP is not supported in Sentinel LDK. Distribution Channel users will be migrated to Sentinel EMS as “disabled” and can be enabled manually in Sentinel EMS. However, Sentinel EMS does not place any restrictions on the users based on Distribution Channel Products. If these users are enabled, they will have access to all Products and to Entitlements for all Products that are a part of the vendor’s Batch Code.

Reports

Sentinel EMS does not provide the same business intelligence reports that exist in Business Studio. (Note, however, that you can define custom reports in Sentinel EMS.)

User Name

In Sentinel HASP, a Business Studio user name can contain the characters “-”, “&”, and space. A Sentinel EMS user name cannot contain these characters. Therefore, any of these characters in a user name is converted to “_”.

A Sentinel EMS user must have an email address. If a Business Studio user does not have an email address, the Migration Tool assigns the email address userName@needs.email.com to the migrated Sentinel EMS user.
Customer Attributes

The Migration Tool converts all customers from the BSS database to customers of type **Company** in Sentinel EMS. The value from the **Name** field in BSS is migrated to the **Company Name** field in Sentinel EMS.

**E-mail** address and **Contact Name** must always be provided together in Sentinel EMS, and **E-mail** address must be unique. These requirements do not exist in Sentinel HASP. Therefore, if either of these does not exist in the BSS database, or if the **E-mail** address is not unique, the Migration Tool places whichever information is available in the **Description** field in the Sentinel EMS database.

The table that follows indicates how the **Name**, **E-mail** and **Contact Person** fields from the BSS database are migrated to the Sentinel EMS database.

<table>
<thead>
<tr>
<th>Business Studio Server (BSS) Database</th>
<th>Sentinel EMS Database</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Customer) Type field</td>
<td>(Customer) Type = Company</td>
</tr>
<tr>
<td>(Customer) Name Field</td>
<td>Company Name Field</td>
</tr>
<tr>
<td>(Customer) E-mail Field</td>
<td>Contact E-mail Field</td>
</tr>
<tr>
<td>Contact Person Field</td>
<td>Contact Name Field</td>
</tr>
<tr>
<td></td>
<td>Description Field</td>
</tr>
<tr>
<td>Unique or Duplicate</td>
<td>None</td>
</tr>
<tr>
<td>Unique</td>
<td>None</td>
</tr>
<tr>
<td>Duplicate</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>Provided</td>
</tr>
<tr>
<td></td>
<td>Provided</td>
</tr>
</tbody>
</table>

**E-mail** address and **Contact Name** must always be provided together in Sentinel EMS, and **E-mail** address must be unique. These requirements do not exist in Sentinel HASP. Therefore, if either of these does not exist in the BSS database, or if the **E-mail** address is not unique, the Migration Tool places whichever information is available in the **Description** field in the Sentinel EMS database.

**Miscellaneous Field Reassignments**

Most data fields from the BSS database are migrated to fields with equivalent names in the Sentinel EMS database.

Exceptions are listed in the table that follows.

<table>
<thead>
<tr>
<th>BSS Database Field</th>
<th>Sentinel EMS Database Field</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Order) Order ID</td>
<td>(Entitlement) Ref ID 2</td>
<td>After migration, the field value in Sentinel EMS is: HASP_OrderID_originalValue</td>
</tr>
<tr>
<td>(Customer) Customer ID</td>
<td>(Customer) CRM ID</td>
<td>After migration, the field value in Sentinel EMS is: HASP_CustomerID_originalValue</td>
</tr>
<tr>
<td>(Customer) Street, City, Zip</td>
<td>(Customer) Street</td>
<td>In Sentinel EMS, the values of the three fields are combined in the Street Field.</td>
</tr>
<tr>
<td>(User) Full Name</td>
<td>(User) Ref ID 1</td>
<td></td>
</tr>
<tr>
<td>(User) Description</td>
<td>(User) Ref ID 2</td>
<td></td>
</tr>
</tbody>
</table>
Migration of Orders for HASP HL Max Micro Keys

Once an order in Business Studio has been associated with a HASP HL Max Micro key, the key will appear in the entitlement in Sentinel EMS as **HL-Max** instead of **HL-Max-Micro**.

(Note that the Max key and Max Micro key are functionally equivalent.)

Migration of Products That Do Not Contain Features

It is possible for a Product to contain memory content for a protection key, but no Features. If a Product with no Features is migrated from the BSS database to Sentinel EMS, the Product will be assigned a new Product ID – it will not receive the original product ID.

**NOTE:** This same behavior occurs when a Sentinel HL key that contains a Product with no Features is checked into a different BSS database – the Product is assigned a new Product ID.

Migration of Completed Orders in the Demo Database

Data for completed orders that is installed with the Demo database as part of the Sentinel HASP installation process is, in part, not well-formed. As a result, if you choose to migrate the Demo database, it will not be possible in Sentinel EMS to download V2C files for completed orders that exist in the Demo database. However, for orders that you entered and completed yourself in the Demo database, no such limitation applies.

This issue has no bearing on your production database.

Performing a Trial Migration

Gemalto has attempted to anticipate and handle any problems that may arise during the migration process. However, to ensure uninterrupted service for your production environment, Gemalto highly recommends that you perform a trial migration and validation of your BSS database in a test environment using the procedures described below. After you complete a trial migration process, perform the validation steps described later in this document (see “Verifying the Success of the Migration Process” on page 20).

**NOTE:** The migration process modifies your BSS database. Do not perform the trial migration with your production BSS database.

As part of your trial migration, be sure to test your implementation of Business Studio Server API for Sentinel EMS (if you use Business Studio Server API in your current production environment).

After you are satisfied that the migration proceeds as expected and that you are prepared to handle any resulting changes, you are ready to perform migration for your production environment.

Preparing for Migration

Estimate Time Required for Migration

Various factors, such as the connection speed to the databases, affect the amount of time required for migration of the BSS database to Sentinel EMS.
The size of the BSS database is the primary factor that determines the amount of time required. The migration process requires approximately one hour for each gigabyte of data to be migrated.

Install SQL Server Management Studio Express and Back Up Your BSS Database

If not already installed, download and install SQL Server 2008 Management Studio Express or later from the Microsoft website. If you have installed SQL Server 2005 Management Studio Express, uninstall it and then install SQL Server 2008 Management Studio Express. Upgrade to the 2008 version is not possible from the 2005 version.

Connect to the BSS database. Make a backup copy of the database.

Install and Back Up Sentinel EMS

Install Sentinel EMS from the latest Sentinel LDK Installation Drive. Gemalto recommends that you install Sentinel EMS and Business Studio Server on different computers. Follow the installation instructions provided in the Sentinel LDK Installation Guide.

**NOTE:** If you want to migrate data for the DEMOMA Batch Code from Sentinel HASP to Sentinel EMS, be sure that during Sentinel EMS installation, in the Sentinel EMS Database Configuration screen, you clear the Fill Demo Data check box for installing demo data.

If Sentinel EMS v.2.1 (from Sentinel LDK 6.0) is present on the computer where you will install the current version of Sentinel EMS, refer to the upgrade instructions in the Installation Guide.

**NOTE:** Sentinel LDK Data Migration Tool provides a built-in function to back up the Sentinel EMS database. You can only use this function if the Sentinel EMS database is located on the computer where you run the Migration Tool.

Set Up Sentinel LDK Data Migration Tool

1. Locate the following directory on the computer where Sentinel LDK Vendor Tools are installed:

   `%ProgramFiles(x86)%\Gemalto\Sentinel\Sentinel LDK\VendorTools\Utilities\BusinessStudioServer-Migration\`

   (For Windows x86, use `%ProgramFiles%`...)

2. Copy the `BusinessStudioServer-Migration` directory and all of its contents to the computer that contains Business Studio Server.

   **NOTE:** If your installation of Business Studio Server was split into separate installations of the Activation Server and Management Server, copy the `BusinessStudioServer-Migration` directory to the computer where the Management Server was installed.

3. Ensure that the version of Java Runtime Environment (JRE) on the computer where the Migration Tool will run is 1.7.0_21 or later (up to JRE 8u211). You can download a compatible version of JRE from:

Determine Batch Codes to be Migrated
If your BSS database contains data for several Batch Codes, then by default, the Migration Tool migrates the data for all Batch Codes to the Sentinel EMS database. (Data for the DEMOMA Batch Code is only migrated if you specifically request this in the Migration Tool.)

If you use multiple Batch Codes (besides DEMOMA) in your BSS database, and you want to migrate only selected Batch Codes to the Sentinel EMS database, do the following:

1. Create a text file named `vendors_blacklist.cfg` in the directory that contains the Migration Tool on the Business Studio Server machine.
2. For each Batch Code that should *not* be migrated, add a line that contains the name of the Batch Code to the `vendors_blacklist.cfg` file.

Ensure That Sentinel EMS and BSS Database Services are Active
The SQL service for the BSS database must be active and accessible to the Migration Tool during the migration process. However, Sentinel HASP applications such as Business Studio or the Activation Server must not be in use.

The SQL service for the Sentinel EMS database must be active and accessible to the Migration Tool during the migration process.

Ensure That the Required Master Keys are Connected
The Sentinel Master Key for each Batch Code that will be migrated must be connected to the Business Studio Server computer during the migration process. No Master key is required for the DEMOMA Batch Code or for any Batch Code in the Blacklist file.

Back Up Sentinel EMS Database and BSS Database (Optional)
The Migration Tool can back up the BSS database or Sentinel EMS database (or both) for you during the migration process. However, this built-in backup functionality can only be used when the database is located on the computer where you run the Migration Tool (that is, on the Business Studio Server machine).

If either database is located on a remote computer, ensure that the database is backed up.
Migrating the BSS Database

**NOTE:** The migration process modifies both your BSS database and Sentinel EMS database. If the migration process fails, be sure to recover both databases from the backups that you create either before or during the migration process.

### Run the Sentinel LDK Data Migration Tool

Run the Sentinel LDK Data Migration Tool as follows:

1. In the Windows Search box, enter: `cmd.exe`
2. Right-click on the displayed `cmd.exe` program and select **Run as administrator**.

3. In the Command Line window, switch to the directory where you placed the Migration Tool on the Business Studio Server computer.
4. To launch the Migration Tool, enter: `Java -jar migrationTool.jar`

Note the following:

- Gemalto recommends that you save the console output to a log file. This log is useful if it is necessary to handle any issue that may occur during migration. To save console output to a log file, use this command to launch the migration tool:

  ```java
  Java -jar migrationTool.jar > console.log 2>&1
  ```

  You can change `console.log` to any other file name.

- If the size of the BSS database is greater than 500 MB, enter the following command to launch the Migration Tool with an increased heap size (and to save console output to a log file):

  ```java
  Java -Xms256m -Xmx1024m -jar migrationTool.jar > console.log 2>&1
  ```
The Migration Tool starts. The following screen is displayed:

5. If you want to migrate demo data (DEMOMA Batch Code) from the BSS database to the Sentinel EMS database, select the **Migrate demo data** check box.

6. Click **Next**.

A screen similar to the following is displayed:

The **User Name** field should contain the name of a user who has full administrator privileges for the BSS database.

**NOTE:** If the **Port** field contains the value 0, this indicates that TCP/IP access for the BSS database is not enabled. To resolve this problem see “Troubleshooting” on page 31.

7. Click **Test Connection** to confirm that the Migration Tool can connect to the database.
Migrating the Business Studio Server Database to Sentinel EMS Database

8. If you have not yet backed up the BSS database, you can click **Back Up Database** now to back it up. (This function can only be used if the BSS database is located on the local machine.)

   **NOTE:** If the database backup fails, refer to “Troubleshooting” on page 31.

9. Click **Next** to continue.

A screen similar to the following is displayed:

10. If Sentinel EMS is installed on a remote computer, enter the connection parameters. The **User Name** field should contain the name of a user who has full administrator privileges for the Sentinel EMS database. If necessary, modify firewall settings so that the Migration Tool can communicate with the Sentinel EMS database server.

11. Click **Test Connection** to confirm that the Migration Tool can connect to the database.

12. If you have not yet backed up the Sentinel EMS database, you can click **Back Up Database** now to back it up. (This function can only be used if the Sentinel EMS database is located on the local machine.)

   **NOTE:** If the database backup fails, refer to “Troubleshooting” on page 31.

13. Click **Next** to continue. A message box is displayed, asking whether you want to restart the Business Studio Server service.

14. Click **OK** to continue.

The migration process begins. This process may require several hours. Progress screens are displayed during this process.

   **NOTE:** If the database preparation phase of the process freezes, refer to “Troubleshooting” on page 31.

Upon completion of the migration process:

- A detailed report of the migration process is displayed in a browser window. The complete contents of this report can also be found in:

  `\BusinessStudioServer-Migration\migration_date_time.html`
Migrating the Business Studio Server Database to Sentinel EMS Database

- A screen similar to the following is displayed:

You can click View Report to reopen the detailed report of the migration process.

Reintroduce the Master Keys

The Sentinel Master key for each Batch Code that was migrated to Sentinel EMS must be reintroduced.

If Sentinel EMS is installed on different computer from Business Studio Server, move the relevant Master keys to the Sentinel EMS computer.

Perform the procedure for introducing Master keys in Sentinel EMS. (This must be done even if Business Studio Server and Sentinel EMS are installed on the same computer.) This procedure is described in the Sentinel LDK Installation Guide.

**NOTE:** After the Master Wizard has downloaded all the libraries, the Wizard may seem to hang, and finally return the error code 850, 852, or 857. If this occurs, see “Troubleshooting” on page 31.

Verifying the Success of the Migration Process

After completion of the migration process, confirm that the data from Sentinel HASP was successfully migrated to the Sentinel EMS database and that Sentinel EMS is handling the data correctly.

Perform the following activities:

> Review the contents of the migration report (described earlier). Determine if any adjustments are required to the migrated data or if any warning require your attention.

> Examine samples of the various entities (such as Features, Products, customers and entitlements) in Sentinel EMS and verify that the information displayed matches the data that exists in Sentinel HASP.

> Generate reports that are available in Sentinel EMS. Review the reports to ensure that the contents are consistent with the expected results.
Perform sample transactions in Sentinel EMS and verify that the transactions complete as expected. Among the transaction you perform, Gemalto recommends that you do the following:

- Download an existing update for a protection key
- Generate a new update for an existing protection key.
- Activate a migrated entitlement.
- Perform a HASP update.

For assistance in performing the validation activities, see “Working With the Sentinel EMS Web Interface” on page 29.

### Stopping the SQL Service for the BSS Database

Once the migration process has completed, stop the SQL service for the BSS database to ensure that no further attempts are made to enter or modify data in the BSS database. Ensure that the Business Studio Server service is stopped and that its **Startup Type** is set to **Disabled**.

### Migrating Backend Systems That Use BSS API

For vendors that work with Business Studio Server API: When you are satisfied that your BSS database has been successfully migrated to the Sentinel EMS database, be sure to perform the necessary steps to prepare your CRM and ERP systems to use the Business Studio Server API for Sentinel EMS.

For more information, see “Implementing the Business Studio Server API for Sentinel EMS” on page 22.

### Performing BSS and Sentinel EMS Database Rollback in Case of Failure

The migration process changes both the BSS database and the Sentinel EMS database. If the migration from Sentinel HASP to Sentinel EMS does not succeed, perform the following steps for each database to roll back the database to its original state.

1. Stop the database server.
2. Restore the database.
3. Start the database server.

The migration process adds certain files in the directory containing the BSS database. These files can be ignored. They will not interfere when you run the migration process again after resolving the problems encountered.
Overview

Sentinel LDK provides a Web Services interface to perform CMR or ERP actions in Sentinel EMS. However, vendors who are working with the Sentinel HASP Business Studio Server API (BSS API) have typically invested extensive time and effort to integrate the API with their existing ERP and CRM infrastructure.

Business Studio Server API for Sentinel EMS (BSS API for EMS) allows you to take advantage of the benefits provided by Sentinel EMS while continuing to use the API calls in the BSS API. Thus, after migration to Sentinel LDK, you can continue to use your existing backend systems with a minimum of modification.

NOTE: In your applications, you have the option of calling functions both in the BSS API for EMS and in Sentinel EMS Web Services. This enables you to take advantage of any new functionality that is not supported in the BSS API.

Prerequisites

You must be using the version of Sentinel EMS that is provided with the latest version of Sentinel LDK. Your backend applications must be compatible with Sentinel Business Studio Server API v.5.0 or later.

Functionality Changes

This section describes changes in the behavior of certain methods in BSS API for EMS.

For more information regarding the methods described in this section, see the business_studio_server_api_en-US.chm help file. This can be found on the computer where Sentinel LDK Vendor Tools are installed, under:

%ProgramFiles(x86)\Gemalto Sentinel\Sentinel LDK\Legacy\API\BusinessStudioServer\

(For Windows x86, use %ProgramFiles%...)

GetExecutableFromV2C

In Sentinel HASP BSS API, this method returns an executable binary.

In BSS API for EMS, this method returns a gzip binary.

Instructions for extracting the V2C content from the gzip binary are provided in Sentinel EMS Web Service Guide, in the topic “Update Protection Key.”
GetKeyHistoryByKeyID Method
The behavior of the GetKeyHistoryByKeyID method in BSS API for EMS is different from the behavior in Sentinel HASP BSS API as follows.

When there is no information to retrieve, the GetKeyHistoryByKeyID method behaves as follows:
- In BSS API for EMS: The method returns NULL.
- In Sentinel HASP BSS API: The method returns zeros.

AddProductsToOrder Method
In Sentinel HASP BSS API, this method adds new Products to an existing order.

In BSS API for EMS, this method replaces all the products in the entitlement with the Products contained in the inProducts array.

Thus, to add Products to an entitlement, the inProducts array must contain both the Products that exist in the entitlement and the Products to add to the entitlement.

Note that this change in the functionality enables you to use the AddProductsToOrder method to remove Products from an existing entitlement.

InsertCustomer Method
In BSS API for EMS, this method will always insert a customer of type Company (rather than Individual). Additional parameters are mapped as follows:

<table>
<thead>
<tr>
<th>Parameter in Sentinel HASP BSS API</th>
<th>Parameter is Mandatory</th>
<th>Parameter in BSS API for EMS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>No</td>
<td>Street</td>
</tr>
<tr>
<td>Contact</td>
<td>Mandatory if Email is provided.</td>
<td>Contact Information: First Name, Last Name, Middle Name</td>
</tr>
<tr>
<td>Email</td>
<td>Mandatory if Contact is provided.</td>
<td>Contact E-mail</td>
</tr>
<tr>
<td>Fax</td>
<td>No</td>
<td>Fax</td>
</tr>
<tr>
<td>Name</td>
<td>Yes</td>
<td>Company Name</td>
</tr>
<tr>
<td>Phone</td>
<td>No</td>
<td>Telephone</td>
</tr>
<tr>
<td>Reference</td>
<td>No</td>
<td>Ref ID</td>
</tr>
<tr>
<td>Status</td>
<td>No</td>
<td>Enabled: Yes or No</td>
</tr>
<tr>
<td>Zip Code</td>
<td>No</td>
<td>Zip Code</td>
</tr>
</tbody>
</table>

(If you want to insert a customer of type Individual, you can use the functions available in the Sentinel EMS Web Services.)

Retrieving Orders Based on Order ID
The GetAllOrders, GetNewOrders, and GetProductionOrders methods search both Ref ID 1 and Ref ID 2 fields in entitlements for the value specified by the inReference parameter. These methods will retrieve orders for which either of these fields contains the specified value. However, the value for the Ref ID 2 field cannot be retrieved using BSS API. After migration from Sentinel HASP to Sentinel EMS, the Order ID value is contained in the Ref ID 2 field. (For more information, see “Miscellaneous Field Reassignments” on page 13.)
Implementing the Business Studio Server API for Sentinel EMS

Therefore, when you use one of these methods to search for entitlements based on the value of Order ID, the method will appear to retrieve entitlements that do not contain the specified value, even though the value is present.

Retrieving Customers Based on Customer ID

The `GetCustomers` method searches both Ref ID and CRM ID fields in customer records for the value specified by the `inReference` parameter. This method will retrieve customers for which either of these fields contains the specified value. However, the value for the CRM ID field cannot be retrieved using BSS API. After migration from Sentinel HASP to Sentinel EMS, the customer ID value is contained in the CRM ID field. (For more information, see “Miscellaneous Field Reassignments” on page 13.)

Therefore, when you use this method to search for customers based on the value of customer ID, the method will appear to retrieve customers that do not contain the specified value, even though the value is present.

Other Changes to BSS API Functions

The following items are not supported in BSS API for EMS:

- `GetProvisionalOrders` (method)
- `ProduceProvisionalOrder` (method)
- `ClearClonedHaspSLKey` (method)
- `OrderType.PROVISIONAL` (enum item)
- `KeyOrders.FormatType` (field)
- `KeyOrders.FormatDate` (field)

The changes below were implemented in BSS API for EMS:

- **EOL** state of entitlement in Sentinel EMS does not exist in Sentinel HASP. Therefore, EOL state is mapped to `OrderStatus.None` in BSS API for EMS.
- **ProductProvisionalOrders** method is not supported. Therefore, public HaspBssStatus `GetProvisionalOrders(int inBatchID, string inReference, out Order[] outOrders)` returns `HaspBssStatus.HASP_BA_NO_ORDERS` in BSS API for EMS.
- **ProduceProvisionalOrder** method is not supported. Therefore, public HaspBssStatus `ProduceProvisionalOrder(int inOrderID, out string outV2C)` returns `HaspBssStatus.HASP_BA_UNSPECIFIED` in BSS API for EMS.
- **ClearClonedHaspSLKey** method is not supported. Therefore, public HaspBssStatus `ClearClonedHaspSLKey(string inC2V, out string outV2C)` returns `HaspBssStatus.HASP_BA_UNSPECIFIED` in BSS API for EMS.
- **GenerateFormatUpdateFile** method returns `HaspBssStatus.HASP_BA_INVALID_INPUT` if the input C2V is empty (already formatted) in BSS API for EMS.

With Business Studio, this method would just generate another Format V2C file, even if the key was already empty/formatted. Currently, Sentinel EMS can generate Format files only against keys that contain personalized Products and Features and/or RAW Memory.
Implementing the Business Studio Server API for Sentinel EMS

Setting Up Business Studio Server API for Sentinel EMS

BSS API for EMS can be set up either as an ASP.NET SOAP web service or locally (as a .NET DLL).

As an ASP.NET SOAP Web Service

You can install BSS API for EMS as a Web Service, either on the computer where you installed Sentinel EMS or on a separate computer in the same network.

This section describes the prerequisites and the procedure for performing this installation.

Ensure Prerequisites

The computer on which you install BSS API for EMS as a Web Service must satisfy the following prerequisites:

- Windows Server 2008 or Windows 7 SP1
- Microsoft .NET Framework version 2.0 or later
- Windows Internet Information Services (IIS) version 5.0 or later
- Windows MSI Installer version 3.1 or later

When you launch the setup executable, the application checks to ensure that the computer satisfies the prerequisites.

- If the presence of the .NET Framework and MSI Installer is not detected, these components are automatically downloaded and installed.
- If the IIS component is not detected, you are prompted to install it manually, and the setup application terminates.

Configure IIS

Depending on the operating system of the computer on which you plan to install BSS API for EMS, if you have installed IIS 7 or IIS 7.5, the following configuration is required to enable compatibility with the IIS 6 metabase:

- Windows 7: Under Programs & Features, go to Turn Windows features on or off > Internet Information Services > Web Management Tools > IIS 6 Management Compatibility and select IIS Metabase and IIS 6 configuration compatibility.
- Windows 2008 Server:
  a. Under Programs & Features, go to Turn Windows features on or off.
  b. In the Server Manager screen - Roles Summary pane, click Go to Roles > Add Roles.
  c. In the Add Roles wizard, click Server Roles in the navigation panel.
  d. Select the Web Server (IIS) check box.
  e. Click Add Required Features.
  f. Click Next.
  g. Click Next.
Implementing the Business Studio Server API for Sentinel EMS

h. Select IIS 6 Management Compatibility.
i. Click Next.
j. Click Install.

Install Business Studio Server API for Sentinel EMS

To install BSS API for EMS as a Web service:

1. Navigate to the following location on the computer where Sentinel LDK Vendor Tools are installed:
   %ProgramFiles(x86)\Gemalto Sentinel\Sentinel LDK\Legacy\API\BusinessStudioServer\WebSetup\
   (For Windows x86, use %ProgramFiles%\...)

2. Double-click setup.exe.
   The BSS API for EMS installation wizard starts.

3. Proceed through the installation wizard. You can accept all defaults or make changes as required.

4. (Optional) Confirm that the Web service was installed correctly by accessing the following URL:
   http://localhost/BusinessAPI/BusinessAPIService.asmx
   If a page describing the Sentinel HASP Business Studio Server API is displayed, the Web Service was installed correctly.

5. In your application, be sure to modify the call to the Initialize method in the BSS API as necessary in order to connect to the Sentinel EMS server.

Configure Use of SSL

By default, Sentinel EMS Service is configured to operate without using SSL. If you have set up Sentinel EMS Service to use SSL, you must also set up BSS API for EMS to use SSL.

You can set up BSS API for EMS to use SSL:

> By modifying the useSSL parameter in the IIS management console.
> By directly modifying the useSSL parameter in the web.config file.

To modify the useSSL parameter in the IIS management console:

1. Start the Internet Information Services (IIS) management console using the method that is appropriate for your operating system.
2. Under the entry for the relevant computer, choose Site (or Web Site). Under Default Web Site, select BusinessAPI > ASP.NET > BusinessAPI > Application Settings. In the Application Settings properties, find the UseSSL key. Change the values for the key to true (to enable SSL).

To modify the useSSL parameter directly in the web.config file:

1. Open the file Web.config in a text editor. This file is typically located in the directory:
   %SystemDrive%/Inetpub/wwwroot/BusinessAPI/%

2. Locate the following line in the file:
   <add key="useSSL" value="false" />

3. To set up BSS API for EMS to use SSL, change the value from false to true.
4. Save the file.
Configure Log File Generation (Optional)

By default, BSS API for EMS does not generate log file entries. You can enable generation of log file entries and set the verbosity level of the API as follows:

1. Open the file Web.config in a text editor. This file is typically located in the directory: %SystemDrive%\Inetpub\wwwroot\BusinessAPI/
2. Locate the following line in the file:
   globalThreshold="Off"
3. Change the value Off to the desired log verbosity level. Possible log verbosity levels are:
   - Debug – Generate verbose log entries. This also includes messages from the Error and Fatal levels.
   - Error – Generate log entries for errors only. This also includes messages from the Fatal level.
   - Fatal – Generate log entries for fatal errors only.
4. Locate the following line in the file:
   <logger name="*"minlevel="Fatal" writeTo="file" />
5. Change the value assigned to minlevel so that it matches the verbosity level assigned to globalThreshold.
6. Save the file.

(To disable generation of log entries, change just the value for globalThreshold back to Off.)

**NOTE:** If BSS API for EMS fails to generate log files after it was properly configured, see “Troubleshooting” on page 31.

Local (As a .NET DLL)

This section describes how to set up the BSS API as a .NET DLL.

1. Navigate to the following location on the computer where Sentinel LDK Vendor Tools are installed:
   %ProgramFiles(x86)%\Gemalto Sentinel\Sentinel LDK\Legacy\API\BusinessStudioServer\bin\ 
   (For Windows x86, use %ProgramFiles%\...)
2. Copy the following files from the bin directory to your DLL directory (all the files must be in the same directory):
   - HaspBusinessStudioServer.dll
   - Nlog.dll
   - HaspBusinessStudioServer.dll.config
   - NLog.config
4. If Sentinel EMS is configured to use SSL, modify HaspBusinessStudioServer.dll.config as follows:
   a. Locate the following line in the file:
      <add key="useSSL" value="false" />
   b. Change the value false to true.
5. By default, BSS API for EMS does not generate log file entries. You can enable generation of log file entries and set the verbosity level of the API. Modify `Nlog.config` as follows:

   a. Locate the following line in the file:
      ```
      globalThreshold="Off"
      ```
   
   b. Change the value `Off` to the desired log verbosity level. Possible log verbosity levels are:
      ```
      Debug – Generate verbose log entries. This also includes messages from the Error and Fatal levels.
      Error – Generate log entries for errors only. This also includes messages from the Fatal level.
      Fatal – Generate log entries for fatal errors only.
      ```
   
   c. Locate the following line in the file:
      ```
      <logger name="*"minlevel="Fatal" writeTo="file" />
      ```
   
   d. Change the value assigned to `minlevel` so that it matches the verbosity level assigned to `globalThreshold`.
   
   e. Save the file.
      
      (To disable generation of log entries, change just the value for `globalThreshold` back to `Off`.)

6. In your application, be sure to modify the call to the `Initialize` method in the BSS API as necessary in order to connect to the Sentinel EMS server.

7. Recompile your .NET application.
APPENDIX A: Working With the Sentinel EMS Web Interface

Vendors who have been working with the Business Studio user interface may require some time to become familiar with the Sentinel EMS Web interface.

The Sentinel EMS Web interface includes a complete online help system. An overview of the Web interface is also provided in the Sentinel LDK Software Protection and Licensing Guide.

To assist you in becoming familiar with the Sentinel EMS Web interface, the table below lists the major activities in Business Studio and provides the equivalent activities in Sentinel EMS.

<table>
<thead>
<tr>
<th>Business Studio Activity</th>
<th>Sentinel EMS Activity</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customers &gt; Define New</td>
<td>Customers &gt; New Customer</td>
<td></td>
</tr>
<tr>
<td>Customers &gt; Manage Activation of a Product</td>
<td>Entitlements &gt; Product Keys &gt; Edit</td>
<td></td>
</tr>
<tr>
<td>Customers &gt; Modify</td>
<td>Customers &gt; Edit</td>
<td></td>
</tr>
<tr>
<td>Customers &gt; Obsolete</td>
<td>Customers &gt; Disable</td>
<td></td>
</tr>
<tr>
<td>Customers &gt; Restore</td>
<td>Customers &gt; Enable</td>
<td></td>
</tr>
<tr>
<td>Development Tasks &gt; Export Definition Data</td>
<td>Developer &gt; Export Catalog Definitions</td>
<td></td>
</tr>
<tr>
<td>Development Tasks &gt; Generate Bundle of Provisional Products</td>
<td>Developer &gt; Bundle Provisional Products</td>
<td></td>
</tr>
<tr>
<td>Development Tasks &gt; Generate Runtime Environment Installer</td>
<td>Developer &gt; RTE Installer</td>
<td></td>
</tr>
<tr>
<td>Development Tasks &gt; RUS Branding</td>
<td>Developer &gt; RUS Branding</td>
<td></td>
</tr>
<tr>
<td>Distribution Channels</td>
<td>(Not supported)</td>
<td></td>
</tr>
<tr>
<td>Manage Features &gt; New</td>
<td>Catalog &gt; Features &gt; New Feature</td>
<td></td>
</tr>
<tr>
<td>Manage Features &gt; Obsolete</td>
<td>Catalog &gt; Features &gt; Action &gt; Obsolete</td>
<td></td>
</tr>
<tr>
<td>Manage Features &gt; Open</td>
<td>Catalog &gt; Features &gt; Actions &gt; Edit</td>
<td></td>
</tr>
<tr>
<td>Manage Orders &gt; Check in C2V</td>
<td>Entitlements &gt; Check in C2V</td>
<td></td>
</tr>
<tr>
<td>Manage Orders &gt; Delete</td>
<td>Entitlements &gt; Actions &gt; Delete</td>
<td></td>
</tr>
<tr>
<td>Manage Orders &gt; New</td>
<td>Entitlements &gt; New Entitlement</td>
<td></td>
</tr>
<tr>
<td>Manage Orders &gt; Open</td>
<td>Entitlements &gt; Actions &gt; Edit</td>
<td></td>
</tr>
<tr>
<td>Manage Orders &gt; Reopen (Change status to On Hold)</td>
<td>Entitlements &gt; Actions &gt; Reopen</td>
<td></td>
</tr>
<tr>
<td>Manage Products &gt; Delete</td>
<td>Catalog &gt; Product &gt; Actions &gt; Delete</td>
<td></td>
</tr>
<tr>
<td>Manage Products &gt; Duplicate</td>
<td>Catalog &gt; Product &gt; Actions &gt; Copy</td>
<td></td>
</tr>
<tr>
<td>Manage Products &gt; New</td>
<td>Catalog &gt; Products &gt; New Product</td>
<td></td>
</tr>
<tr>
<td>Manage Products &gt; New Cancellation</td>
<td>Catalog &gt; Product &gt; Actions &gt; Cancellation</td>
<td></td>
</tr>
<tr>
<td>Business Studio Activity</td>
<td>Sentinel EMS Activity</td>
<td>Notes</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Manage Products &gt; New Modification</td>
<td>Catalog &gt; Product &gt; Actions &gt; Modification</td>
<td></td>
</tr>
<tr>
<td>Manage Products &gt; New Provisional</td>
<td>Catalog &gt; Product &gt; Actions &gt; Provisional</td>
<td></td>
</tr>
<tr>
<td>Manage Products &gt; Obsolete</td>
<td>Catalog &gt; Product &gt; Actions &gt; End of Life</td>
<td></td>
</tr>
<tr>
<td>Manage Products &gt; Open</td>
<td>Catalog &gt; Product &gt; Actions &gt; Edit</td>
<td></td>
</tr>
<tr>
<td>Manage Products &gt; Restore</td>
<td>Catalog &gt; Product &gt; Actions &gt; Complete</td>
<td></td>
</tr>
<tr>
<td>Master Keys &gt; Apply Licenses to Master Key</td>
<td>Administration &gt; Master &gt; Update Master</td>
<td></td>
</tr>
<tr>
<td>Master Keys &gt; Configure Email Notification</td>
<td>Administration &gt; Master &gt; E-mail Notification</td>
<td></td>
</tr>
<tr>
<td>Master Keys &gt; Editing Batch Code Properties</td>
<td>(Not supported)</td>
<td></td>
</tr>
<tr>
<td>Master Keys &gt; Introducing</td>
<td>Start Menu &gt; Programs &gt; Gemalto Sentinel &gt; Sentinel LDK &gt; Tools &gt; Sentinel Master Wizard</td>
<td></td>
</tr>
<tr>
<td>Master Keys &gt; Order Licenses</td>
<td>Administration &gt; Master &gt; Collect Information</td>
<td></td>
</tr>
<tr>
<td>Master Keys &gt; View Master Key License Details</td>
<td>Administration &gt; Master</td>
<td>Select the Master key to view.</td>
</tr>
<tr>
<td>Production &gt; Check in C2V and Key data</td>
<td>Entitlements &gt; Check In Key</td>
<td></td>
</tr>
<tr>
<td>Production &gt; Define Production Order</td>
<td>Entitlements &gt; Actions &gt; New</td>
<td></td>
</tr>
<tr>
<td>Production &gt; Edit Memory at order time</td>
<td>Entitlements &gt; New Entitlement &gt; Memory</td>
<td></td>
</tr>
<tr>
<td>Production &gt; Produce</td>
<td>Entitlements &gt; Actions &gt; Produce</td>
<td></td>
</tr>
<tr>
<td>Production &gt; Recycle Keys</td>
<td>Entitlements &gt; Recycle</td>
<td></td>
</tr>
<tr>
<td>Production &gt; View</td>
<td>Entitlements</td>
<td>Select the Entitlement to view.</td>
</tr>
<tr>
<td>Reports &gt; Generate Reports</td>
<td>Reports &gt; Generate Report</td>
<td></td>
</tr>
<tr>
<td>Reports &gt; Scheduling</td>
<td>Reports &gt; Scheduled Reports</td>
<td></td>
</tr>
<tr>
<td>Users &gt; Change Password (for another user)</td>
<td>Administration &gt; Users &gt; Edit &gt; Change Password</td>
<td></td>
</tr>
<tr>
<td>Users &gt; Change Password (for your own password)</td>
<td>Change Password (from main screen)</td>
<td></td>
</tr>
<tr>
<td>Users &gt; Defining</td>
<td>Administration &gt; Users &gt; New User</td>
<td></td>
</tr>
<tr>
<td>Users &gt; Modifying</td>
<td>Administration &gt; Users &gt; Edit</td>
<td></td>
</tr>
</tbody>
</table>
This appendix describes possible solutions to certain issues that may occur during the migration process or when attempting to work with BSS API for EMS.

The following issues are described:

> TCP/IP Access Is Not Enabled for the BSS Database
> The Master Wizard Returns Error Code 850, 852, or 857
> Migration Tool Fails to Back Up BSS Database or EMS Database
> Migration Tool Freezes During the Pre-migration Process
> BSS API for EMS Fails to Generate Log Files

## TCP/IP Access Is Not Enabled for the BSS Database

When you start the Migration Tool: If the **Port** field contains the value 0 (as demonstrated below), this indicates that TCP/IP access for the BSS database is not enabled. A screen similar to the following is displayed:

![Sentinel LDK Data Migration Tool](image)

**Source Database - Sentinel HASP Business Studio Server**

Specify the source database to migrate, backup the database (optional), and then click Next.

- **Database Name:** SUMServer
- **Host:** TLV000078
- **Port:** 0
- **Instance Name:** HASPERMDATABASE
- **User Name:** sa
- **Password:** ********

[Back Up Database] [Test Connection] [<< Back] [Next >>] [Cancel]
To resolve this, enable TCP IP access for the BSS database as follows:

1. Open the SQL 2005 Configuration Manager and enable TCP/IP as demonstrated in the screen below:
   a. In the SQL Server Configuration Manager, select **Protocols for HASPSRMDATABASE** (1).
   b. Under Protocol Name, select **TCP/IP** (2).
   c. In the TCP/IP Properties dialog box, on the **Protocol** tabbed page, set **Enabled** (3) to **Yes**; then click **OK**.

2. Restart the service: SQL SERVER (HASPSRMDATABASE).

3. In the SQL Server Configuration Manager, redisplay the TCP/IP Properties dialog box as you did in step 1 above.

4. In the TCP/IP Properties dialog box, select the **IP Address** tabbed page.

5. Scroll down to find the correct port as shown below.
6. Enter this port in the Source Database window in the Migration Tool. The Migration Tool is now able to connect to the BSS database. Click the **Test Connection** button to verify the connection.

### The Master Wizard Returns Error Code 850, 852, or 857

When you run the Master Wizard to re-introduce the Master keys after you run the Migration Tool, the Wizard may seem to hang, and finally return the error code 850, 852, or 857. If this occurs, run the following SQL script (insert your Batch Code where indicated):

```
USE SRMServer;
update T_VENDOR
set Verified = 'True'
where BatchCode = 'yourBatchCode'
delete from T_VENDOR_FILE
where VendorID=(select VendorID from T_VENDOR where BatchCode = 'YOURBATCHCODE')
and VendorFileTypeID!=3
```

After the script completes, run the Master Wizard again. (The Wizard will run much faster the second time because your API has already been generated.)
Troubleshooting

Migration Tool Fails to Back Up BSS Database or EMS Database

When you click the Back up Database button in the Migration Tool, the backup process may fail with the following message:

   The backup file cannot be saved to the specified location – access was denied. Choose a different location.

This error may occur if the SQL service that is used to back up the database does not have the required authorization to write to the directory chosen as the backup location.

To resolve this problem:
1. Open the Services window on the local computer.
2. Display the Properties screen for the SQL Server service
3. On the Log On tabbed page, select Log on as Local System account.
4. Click OK.
5. Click the Back Up Database button again.

Migration Tool Freezes During the Pre-migration Process

The Migration Tool may stop responding while it prepares the BSS database for migration. The following window is displayed for an extended period of time (approximately 20 minutes):

![](image)

If this occurs, click Cancel and restart the Migration Tool. It is not necessary to back up the BSS database or Sentinel EMS database again at this point.

If the same problem continues to occur after one or two retries, clean up the BSS database as described below, and restart the process.
Troubleshooting

To clean up the BSS database:

1. Click **Cancel** to stop the Migration Tool.
2. Connect to the BSS database using SQL Server Management Studio and do the following:
   a. Back up the BSS database.
   b. Run the following scripts in the indicated order:
      1) `CleanKeyOrderForMigration.sql`
      2) `ModifyKeyOrderForMigration.sql`
      3) `CreateStatsAndIndexesForPerformance.sql`

      These can be found on the Sentinel LDK Installation Drive, in the directory:

      `\Windows\Installed\VendorTools\Utilities\BusinessStudioServer-Migration\bss\Handler\HASPProductionManageMigration\sql\mssql`

3. Restart the Migration Tool.

**BSS API for EMS Fails to Generate Log Files**

Under certain operating systems (such as Windows Vista, Windows 7, Windows 2008), BSS API for EMS may fail to generate log files even if properly configured.

This problem will occur if the user account under which the ASP.NET process runs does not have write access to the directory that contains the log files for the API.

To resolve this problem, ensure that the user account under which the ASP.NET process runs has the necessary write access.

By default, the log files are written to the directory where BSS API for EMS is installed. By default, this directory is: `%SystemDrive%/Inetpub/wwwroot/BusinessAPI/`

If the user account for the ASP.NET process does not have write access to the directory above, you can assign a different directory to contain the log files.

To change the directory to contain the BSS API for EMS log files:

1. Open the file `Web.config` in a text editor. This file is typically located in the directory:
   `%SystemDrive%/Inetpub/wwwroot/BusinessAPI/`
2. Locate the following line in the file:
   ```
   fileName="${basedir}/logs/${shortdate}.log"
   ```
3. Replace `${basedir}` with the directory to contain the log files. For example, if you want the log files to be written to the subdirectory `logs` under `c:\temp`, change the line as follows:
   ```
   fileName="c:\temp/logs/${shortdate}.log"
   ```
4. Save the file.
5. Ensure that the specified directory (in this example, `c:\temp`) exists.
APPENDIX C: Replace Obsolete Certificate

This appendix describes how to replace the Business Studio Server `keystore.HASP` certificate file in case the Activation API is from a version of Sentinel HASP earlier than v.5.10.

Before you begin

Notify Gemalto Technical Support that you require the Business Studio Server `keystore.HASP` certificate file. After you receive the file, proceed with the remainder of this procedure.

Enable SSL (HTTPS) in Sentinel EMS

1. From the Windows Start menu, go to: Control Panel > Programs and Features
2. Right-click Sentinel LDK and select Change. The Sentinel LDK Installation Wizard starts.
4. Stop the Sentinel EMS Service (From the Start menu, select: All Programs > Gemalto Sentinel > Sentinel EMS > Stop EMS Service)
5. Place the `keystore.HASP` certificate file in the path:
   
   `%ProgramFiles(x86)%\Gemalto Sentinel\Sentinel EMS\EMSServer`
   
   (For Windows x86, use `%ProgramFiles%`...)
6. Open the following file in a text editor:
   
   `%ProgramFiles(x86)%\Gemalto Sentinel\Sentinel EMS\EMSServer\conf\server.xml`
   
   (For Windows x86, open `%ProgramFiles%`...)
7. Locate the `<Connector.../>` tag within server.xml. Change the tag as follows:
   
   a. Set the password in the parameter `keystorePassSet` as follows: `keystorePass="aladdin"
   
   b. Set the certificate path as follows:
      
      `keystoreFile="%ProgramFiles(x86)%\Gemalto Sentinel\Sentinel LDK\EMSServer\keystore.HASP"
      
      (For Windows x86, use `%ProgramFiles%`...)
8. Start the Sentinel EMS Service (From the Start menu, select: All Programs > Gemalto Sentinel > Sentinel EMS > Start EMS Service)
APPENDIX D: Modify Product Key Validation

The format of the Product Key that is generated in Sentinel EMS is different from the format used in Sentinel HASP.

If you have added an integrity check (using Activation API) to verify that the entered Product Key type is valid, do one of the following:

- Change your source code logic so that it is compatible with the new Product Key format.
- In the Sentinel EMS configuration, change the Product Key format so that it satisfies the integrity check that you implemented. For more information, see “Customizing the Product Key” in the Sentinel EMS Configuration Guide.